102011

©2011 Blackbaud, Inc. This publication, or any part thereof, may not be reproduced or transmitted in any form or by any means, electronic, or mechanical, including photocopying, recording, storage in an information retrieval system, or otherwise, without the prior written permission of Blackbaud, Inc.

The information in this manual has been carefully checked and is believed to be accurate. Blackbaud, Inc., assumes no responsibility for any inaccuracies, errors, or omissions in this manual. In no event will Blackbaud, Inc., be liable for direct, indirect, special, incidental, or consequential damages resulting from any defect or omission in this manual, even if advised of the possibility of damages.

In the interest of continuing product development, Blackbaud, Inc., reserves the right to make improvements in this manual and the products it describes at any time, without notice or obligation.

All Blackbaud product names appearing herein are trademarks or registered trademarks of Blackbaud, Inc.

All other products and company names mentioned herein are trademarks of their respective holder.

FE-ConsolidationManagementGuide-102011
Consolidation Management

Consolidation Management Process Summary ........................................... 2
Configuring Consolidation Management .................................................... 2
Configuring Your Default Currency ............................................................ 3
Consolidation Management Default Accounts ............................................. 4
Establishing Consolidation Management Security ....................................... 7
Creating Consolidation Export Files ........................................................... 7
Account Structure Export Files ................................................................. 8
Account Activity Export Files ................................................................. 9
Creating Consolidation Maps ........................................................................ 12
Common Consolidation Map Tools and Options ......................................... 12
Adding a Consolidation Map ......................................................................... 12
Defining Currency Exchange Rates ............................................................. 18
Importing Subsidiary Information ............................................................... 19
Retranslating General Ledger Transactions ............................................... 22
Revaluing Balances and Activity ............................................................... 24
Deleting Subsidiary Batches ........................................................................ 26
Consolidation Reports .................................................................................. 27
Consolidation Dashboard Panels ............................................................... 28
The optional module *Consolidation Management* provides an integrated *Financial Edge* solution for clients who operate multiple organizations (including both profit and nonprofit) and want to generate consolidated data while maintaining the separation required for operating and tax purposes.

**Note:** With *Query* and *Consolidation Management*, you can access the consolidation database and run account, project, and transaction queries. You can also enter criteria to query transactions by subsidiary.

Because *Consolidation Management* is an integrated solution, consolidated reporting is accomplished without manually exporting and combining data using third-party database or spreadsheet software. Integration with *The Financial Edge* also means the entire process runs smoothly from the familiar *Financial Edge* shell.

*Consolidation Management* works by exporting transaction activity from all subsidiaries, even those with different currencies and account structures, and then importing that activity to a separate consolidation database. Once the transaction activity is in the consolidation database, you can use the reporting capabilities of *The Financial Edge* to produce financial reports and dashboard views of subsidiary activity.

**Tip:** If you have both optional modules *Accounting Queue* and *Consolidation Management*, you can setup queues to run in your consolidation database. For more information about setting up and running queues, see the *Accounting Queue Guide*.

To use the optional module *Consolidation Management*, you must have multiple subsidiary databases all with individual instances of *General Ledger*. You must purchase *Consolidation Management*, which includes a separate database that you can designate as the consolidation database. You are not required to use the included database for this purpose. However, you must designate one of your Blackbaud databases as the consolidation database in order to collect and process the consolidated activity from your subsidiary databases.

## Consolidation Management Process Summary

This section provides a basic process summary illustrating the steps involved in using *Consolidation Management*. It is meant to provide an overview of the process and give you a sense of what is involved.

**Step 1.** Configure *Consolidation Management* by defining a default currency and default accounts for your consolidation database.

**Step 2.** Create an account structure export file from the Administration page of each subsidiary database.

**Step 3.** From the Consolidation page of the consolidation database, create an accurate consolidation map for each subsidiary database.

**Note:** If you have subsidiaries with multiple currencies, you will have to apply updated currency rates to existing transactions on an ongoing basis.

**Step 4.** If you have subsidiary databases with activity in multiple currencies, define currency exchange rates from the Consolidation page of the consolidation database.

**Step 5.** Create an account activity export file from the Administration page of each subsidiary database.

**Step 6.** From the Consolidation page of the consolidation database, import the account activity export files you created in step 5.

**Step 7.** Now you can generate reports from the consolidation database, including Balance Sheets and Income Statements, that include consolidated subsidiary activity.

## Configuring Consolidation Management

This section provides information and procedures for configuring default accounts and assigning a default currency for your consolidation database. It also provides information about establishing security settings.
Configuring Your Default Currency

After installing Consolidation Management, the default currency type for your consolidation database is the US Dollar. However, you can quickly and easily select a different default currency from the Configuration page of your consolidation database. If you have imported subsidiary activity, you must delete all batches before you can change the default currency.

Setting a Default Consolidation Currency

**Note:** The default currency setting is required and is only available in your consolidation database.

Before changing your default consolidation currency, you must delete all batches in your consolidation database.

2. From the Configuration page of your consolidation database, click General. The General page appears.

![Configuration page of General Ledger](image)

**Note:** The currency types available in the Consolidation currency field are determined by the entries in the Currency Type table, which you can edit.
3. In the **Consolidation currency** field, select the currency type to use as the default for your consolidation database. If a currency type is designated as inactive in the **Currency Type** table, you cannot select it here.

![Configuration - General](image)

Your new default currency is saved once you exit the General page and/or access another area of the program.

**Consolidation Management Default Accounts**

One of the first tasks you should complete in your consolidation database is accessing **Configuration** and entering your consolidation default accounts. In your consolidation database, you can define three types of default accounts: (1) Unrealized Currency Gain, (2) Unrealized Currency Loss, and (3) Currency Translation Rounding.

**Unrealized Currency Gain**

When you define the Unrealized Currency Gain default account, you have several options. You can define a single account to use for all funds and currencies, or multiple accounts for specific funds and currencies with a single account to be used for the unspecified funds.

![Unrealized Currency Gain](image)

**Options for Unrealized Currency Gain.** You can build the default account by combining the fund segment of each balance sheet account revalued with account segments that you designate. You can also define accounts to use with specific funds and designate a single account to use with the remaining funds while creating interfund entries as needed. With this option, a single account is used for all funds and currencies.
Unrealized Currency Loss

When you define the Unrealized Currency Loss default account, you have several options. You can define a single account to use for all funds and currencies, or multiple accounts for specific funds and currencies with a single account to be used for the unspecified funds.

<table>
<thead>
<tr>
<th>Unrealized Currency Loss</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build the default Unrealized Currency Loss Account by combining the fund of balance sheet account revalued with these segment values:</td>
</tr>
<tr>
<td>Account:</td>
</tr>
<tr>
<td>Unless a Fund has its own Unrealized Currency Loss Account defined in the table below, use this account as the default Unrealized Currency Loss Account, creating interfund entries as needed.</td>
</tr>
<tr>
<td>Account:</td>
</tr>
<tr>
<td>If you always want to use a specific Unrealized Currency Loss Account for a particular Fund, enter it here.</td>
</tr>
</tbody>
</table>

**Options for Unrealized Currency Loss.** You can build the default account by combining the fund segment of each balance sheet account revalued with account segments that you designate. You can also define accounts to use with specific funds, and designate a single account to use with the remaining funds while creating interfund entries as needed.

Currency Translation Rounding

You can define the Currency Translation Rounding default account to handle currency translation rounding differences you encounter when importing subsidiary activity. With this account, any rounding differences are debited and/or credited to keep transactions in balance.

<table>
<thead>
<tr>
<th>Currency Translation Rounding Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up a default account for currency translation rounding differences encountered during subsidiary import that will be debited or credited to keep transaction characteristics in balance.</td>
</tr>
<tr>
<td>Build the default Currency Translation Rounding Account by combining the fund of imported journal entry transactions with these segment values:</td>
</tr>
<tr>
<td>Account:</td>
</tr>
<tr>
<td>Unless a Fund has its own Currency Translation Rounding Account defined in the table below, use this account as the default Currency Translation Rounding Account, creating interfund entries as needed.</td>
</tr>
<tr>
<td>Account:</td>
</tr>
<tr>
<td>If you always want to use a specific Currency Translation Rounding Account for a particular Fund, enter it here.</td>
</tr>
</tbody>
</table>

**Options for the Currency Translation Rounding.** You can build the default account by combining the fund segment of imported journal entry transactions with account segments that you designate. You can also define accounts to use with specific funds, and designate a single account to use with the remaining funds while creating interfund entries as needed.

Defining Consolidation Management Default Accounts

Although the purpose of each default account is different, the process for configuring each is very similar. The example used for this procedure specifically guides you through defining a default account for unrealized currency gain. However, the same basic procedure can be used to define any of the three default accounts.
- **Defining a default account for unrealized currency gain**

  1. Access *General Ledger* from your consolidation database. On the navigation bar, click *Configuration*.
  2. From the Configuration page, click *Default Accounts*. The Default Accounts page appears.

  3. In the box on the left, select *Unrealized Currency Gain*. The Unrealized Currency Gain default account options appear.

  4. To set a default account that automatically balances by fund and segment (if required), mark *Build the default Unrealized Currency Gain Account by combining the fund of balance sheet account with these segment values*.

  5. In the *Account* field, enter an account number. You can use the small binoculars to search for an account segment or use the large binoculars to search for an account number.
6. To define a primary default account and one or more secondary accounts, mark **Unless a Fund has its own Unrealized Currency Gain Account defined in the table below, use this account as the default Unrealized Currency Gain Account, creating interfund entries as needed.**

   ![Unrealized Currency Gain Table]

   **Unrealized Currency Gain**
   - Balance sheet account revalued with these segment values:
   - If you always want to use a specific Unrealized Currency Gain Account for a particular Fund, enter it here:

<table>
<thead>
<tr>
<th>Unrealized Currency Gain</th>
<th>Account Description</th>
<th>Fund Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

   7. In the **Account** field, enter an account number. You can use the small binoculars to search for an account segment or use the large binoculars to search for an account number.

   8. In the grid, in the **Unrealized Currency Gain** column, enter secondary default account numbers. The account descriptions and fund descriptions appear automatically, based on the accounts you enter.

   9. When you exit the Default Account page or highlight another type of account, your changes are saved automatically.

**Establishing Consolidation Management Security**

Security settings, traditionally assigned by an administrator or supervisor, define the level of access users have to all areas of *The Financial Edge*. These settings determine the options and tabs visible to a user, whether the user can view, add, edit, or delete various items, and the functions he/she can perform throughout the program.

To maintain system control and information integrity when dealing with *Consolidation Management*, you can assign or deny user privileges for various *Consolidation Management* tasks. Defining privileges is important for maintaining the security of your system. Only those users who need access to *Consolidation Management* should have user privileges.

We have provided several levels of privileges so you can configure access for specific users. You can assign user privileges for the consolidation database, as well as the subsidiary database. For the consolidation database, you can assign view, add, edit, and delete privileges for consolidation maps, currency exchange rates, importing subsidiary files, and revaluing balances and activity. For the subsidiary database, the user privileges for creating consolidation export files are controlled by the privileges defined in *Administration* for **General Ledger**.

For more detailed information about security, including step-by-step procedures, see the *Administration Guide*.

**Creating Consolidation Export Files**

To generate consolidated reports in *Consolidation Management*, you first need to send account structure information and activity from your subsidiary databases to the consolidation database.

You create subsidiary export files from the Administration page of your subsidiary databases. The export files you create are always *Microsoft Access Database* files (.mdb). Once created, you access your consolidation database and import the files.

There are two types of subsidiary export files used in *Consolidation Management*: account structure and account activity.
Account Structure Export Files

You create account structure export files in your subsidiary databases, and then access the consolidation database to import the account structure files. The files are used in the consolidation database to create consolidation maps that communicate the account structure of each subsidiary to the consolidation database.

Creating an account setup export file


2. On the Administration page, click Create consolidation export file. The Create Consolidation Export File screen appears.

3. In the Export file type field, select “Account structure”.

4. In the Export file path field, enter the location where you want to save the account setup export file, as well as a name for the export file. For example, “C:\Files\account_setup_file_1.mdb”. Click the browse button to navigate to a save location. It may be helpful to write down the path and file name, although they are both included in the control report.

5. To automatically print a control report, mark Print a control report on and select a default printer. If you would rather preview the control report before printing, do not mark this checkbox.

Note: The Consolidation Export Report for account setup export files contains the date and time the file was created, the name and location of the file, and the characteristics included in the file.

6. When you are ready to create the export file, click Create Now. Once the export file is created, a confirmation screen appears notifying you of success.

7. Click OK. Your account setup export file is complete. If you marked Print a control report on, a control report is automatically sent to the default printer. The control report contains helpful information including the location of the file and the characteristics included. If you did not mark Print a control report on, a preview of the Consolidation Export Report appears.

Once you create account structure export files, you can import them form the consolidation database and use them to create consolidation maps.

Account Activity Export Files

You create account activity export files in your subsidiary databases. These export files are used to move account activity information from the subsidiary databases to the consolidation database. Once the export files are created, you access the consolidation database and import the files, which are then used to create consolidated reports.
Creating an account activity export file


2. On the Administration page, click Create consolidation export file. The Create Consolidation Export File screen appears.
3. In the Export file type field, select “Account activity”. The Create Consolidation Export File screen changes, now displaying a General tab, a Funds tab, and fields for defining account activity information.

4. In the Export file path field, enter the location where you want to save the account activity export file, as well as a name for the export file. For example, “C:\Files\account_activity_file_001.mdb”. Click the browse button to navigate to a save location. It may be helpful to write down the path and file name, although they are both included in the control report.

5. In the Post date field, select the post date option to use when designating account activity to be included in the export file. The post date option you select may add or remove fields from the screen. For example, if you choose “<Specific fiscal periods>”, fields will appear in which you define start and end years, as well as start and end periods.

6. To summarize account activity by period, which generates a summary entry of debits and credits by period and account number for the subsidiary, mark Summarize activity by period and select a journal in the Journal field.

7. To include beginning balances in the account activity, which maximizes accuracy of your consolidated Balance Sheet, mark Include beginning balances and select a journal in the Journal field.

8. To automatically print a control report, mark Print a control report on and select a default printer. If you would rather preview the control report before printing, do not mark this checkbox.

9. Select the Funds tab to designate funds to include or exclude from the export. All funds are included by default.

Note: The Consolidation Export Report for account setup export files contains the date and time the file was created, the name and location of the file, and the characteristics included in the file.

10. When you are ready to create the export file, click Create Now. Once the export file is created, a confirmation screen appears notifying you of success.

11. Click OK. Your account setup export file is complete. If you marked Print a control report on, a control report is automatically sent to the default printer. The control report contains helpful information including the location of the file and the characteristics included. If you did not mark Print a control report on, a preview of the Consolidation Export Report appears.

Once you create account activity export files, you can import them from the consolidation database and create consolidated reports.
Creating Consolidation Maps

The consolidation map is used to assign consolidation accounts and transaction characteristics to subsidiary transactions as they are imported into the consolidation organization database. Before attempting to create a consolidation map, you should create account structure export files in your subsidiary databases.

Consolidation maps specify how subsidiary accounts and characteristics are translated to the consolidation accounts and characteristics in the consolidation database. The consolidation map is created through a series of steps in which you specify segments and characteristics using the account structure files exported from the subsidiary databases.

Each consolidation map has multiple tabs for mapping funds, account codes, account number segments, class, projects, and transaction codes. The tabs for project and transaction codes appear only if you have the optional module *Projects and Grants*.

Once you successfully create a consolidation map, you can import account activity export files from subsidiaries and generate consolidated reports.

Common Consolidation Map Tools and Options

On each tab of the consolidation map record, you have a number of common menu items you can use to make the mapping process more efficient. You can access these tools and options on the action bar of consolidation map records. Some are also available on the Consolidation Map menu.

**New.** Click this button on a corresponding tab to add a new fund, account code, user-defined segment, class, project, or transaction code.

**Open.** Click this button on a corresponding tab to open a fund or account code record.

**Find.** Click this button on a corresponding tab to search for a fund, account code, user-defined segment, class, project, or transaction code.

**Auto-map.** Click this button on a corresponding tab to quickly and easily map funds, account codes, user-defined segment, class, projects, or transaction codes.

**Copy from.** Click this button on a corresponding tab to copy mapping characteristics from a previously created consolidation map. You can use the tool to copy maps for funds, account codes, user-defined segment, class, projects, or transaction codes.

**Validate.** Click this button on a corresponding tab to check the validity of mapped funds, account codes, user-defined segments, class, projects, or transaction codes.

**Clear All.** Click this button on a corresponding tab to clear all mapping designations and return to a fresh screen.

**Refresh Account Structure.** Select Refresh Account Structure on the Consolidation Management menu to refresh subsidiary data by re-importing an account structure file.

**Auto-map all.** Select Auto-map All on the Consolidation Management menu to quickly and easily map all funds, account codes, user-defined segments, class, projects, and transaction codes on all tabs.

**Copy From All.** Select Copy From All on the Consolidation Management menu to copy all mapping characteristics from a previously created consolidation map.

**Validate All.** Select Validate All on the Consolidation Management menu to check the validity of all mapped funds, account codes, user-defined segments, class, projects, and transaction codes.

Adding a Consolidation Map

Each consolidation map has multiple tabs for mapping funds, account codes, account number segments, class, projects, and transaction codes. The tabs for project and transaction codes appear only if you have the optional module *Projects and Grants*. 
Once you successfully create a consolidation map, you can import account activity export files from subsidiaries and generate consolidated reports.

- Adding a consolidation map
  Once you add a consolidation map record, you can access each tab on the record to map funds, account codes, and other characteristics.

**Warning:** Before you can add a consolidation map, you must designate a consolidation currency on the General page of Configuration.

1. Access **General Ledger** from your consolidation database. On the navigation bar, click **Consolidation**. The Consolidation page appears.

2. Click **Consolidation Maps**. The Consolidation Maps page appears.

3. On the action bar, click **New**. The Import Subsidiary Account Setup File screen appears.
4. In the **Import** field, click the browse button to locate the account structure file to use for this consolidation map.

5. After you enter the account structure file, click **Import Now** to begin importing the account structure information. Once the process is complete, a new consolidation map screen appears displaying the name of the subsidiary in the title bar.

6. The **Subsidiary** field displays the name of the subsidiary whose information is in the account structure file. You can change the name that appears by editing the field.

7. In the **Subsidiary currency** field, select the correct currency if it differs from the default.

8. In the **Comments** field, you can enter helpful comments about this consolidation map.
9. On the Fund tab, you map funds from the subsidiary database to the consolidation database. The funds already established in your consolidation database appear in the left two columns of the grid. To map funds, access the **Include** column in each row of the grid and select a mapping option for each fund. You can include All, Selected, Range, or None. Once you complete mapping the subsidiary funds to the consolidating organization funds, proceed to the Account tab.

10. On the Account Code tab, you map account codes from the subsidiary database to the consolidation database. The account codes to which you can map subsidiary codes are displayed in the left two columns of the grid. To map account codes, access the **Include** column in each row of the grid and select a mapping option for each account code. You can include All, Selected, Range, or None. To enable automatic adding and mapping of subsidiary values when transactions are imported, mark the corresponding checkbox. Once you complete mapping the subsidiary account codes to the consolidating organization codes, proceed to the next tab.

11. If you have tabs for user-defined account number segments, select the first one now. For this procedure, we are using “Department tab” as an example of a user-defined tab.

![Community Services Inc.](image)
12. On the Department tab (or other tabs for user-defined segments), you map user-defined characteristics from the subsidiary database to the consolidation database. In the **Map to this subsidiary’s values for** field, select the subsidiary user-defined segment values to map to the consolidation values on the Department tab.

The department values you select are displayed in the left two columns of the grid. To map departments, access the **Include** column in each row of the grid and select a mapping option for each code. You can include All, Selected, Range, or None. To enable automatic adding and mapping of subsidiary values when transactions are imported, mark the corresponding checkbox. Once you complete mapping values on the Department tab and subsequent account segment tabs, proceed to the Class tab.

13. On the Class tab, you map values from the subsidiary database to the Class characteristic in the consolidation database. In the **Map to this subsidiary’s values for** field, select the subsidiary values to map to the consolidation values.

The class values you select are displayed in the first column on the left side of the grid. To map classes, access the **Include** column in each row of the grid and select a mapping option for each class. You can include All, Selected, Range, or None. To enable automatic adding and mapping of subsidiary values when transactions are imported, mark the corresponding checkbox. Once you complete mapping the subsidiary class values, proceed to the next tab.
14. If you have established projects in your consolidation database, select the Project tab.

15. On the Project tab, you map values from the subsidiary database to projects defined in the consolidation database. In the Map to this subsidiary's values for field, select the subsidiary values to map to the consolidation projects. Once the grid is populated with projects, you can use the filters on the action bar to sort by type and status.

The project values you select are displayed in the grid. To map projects, access the Include column in each row of the grid and select a mapping option for each project. You can include All, Selected, Range, or None. To enable automatic adding and mapping of subsidiary values when transactions are imported, mark the corresponding checkbox. Once you complete mapping the subsidiary projects, proceed to the next tab.

16. If you have transaction codes defined in your consolidation database, select the first transaction code tab. For this procedure, we are using “Mission tab” as an example of a transaction code tab.
17. On the Mission tab, you map values from the subsidiary database to transaction codes defined in the consolidation database. In the **Map to this subsidiary’s values for** field, select the subsidiary values to map to the consolidation transaction code.

The transaction code values you select are displayed in the grid. To map codes, access the **Include** column in each row of the grid and select a mapping option for each. You can include All, Selected, Range, or None. To enable automatic adding and mapping of subsidiary values when transactions are imported, mark the corresponding checkbox. Once you finish mapping the first transaction code tab, continue mapping the remaining transaction code tabs.

18. Once you finish mapping each tab, your consolidation map for the corresponding subsidiary database is complete. Click **Save and Close** to return to the Consolidation Maps page.

### Defining Currency Exchange Rates

Organizations composed of multiple individual corporations often have to deal with foreign currencies. With Consolidation Management, you can define and maintain currency exchange rates used to translate activity from multiple currencies to the default currency designated by your consolidation database. This is integral to generating accurate consolidated subsidiary data.

In your consolidation database, you add and maintain the currency exchange rates that are used to translate subsidiary activity in foreign currencies to the default currency.

- **Adding a currency exchange rate**
  1. Access **General Ledger** from your consolidation database. On the navigation bar, click **Consolidation**. The Consolidation page appears.
2. Click **Currency Exchange Rates**. The Currency Exchange Rates page appears.


4. In the **Exchange from currency type** field, select the currency type you want to translate to the default currency. The current default currency is displayed to the right of the field. If you enter a new currency type, you are prompted to add the new type to the **Currency Type** table.

5. In the grid, enter the fiscal year and period containing the activity for which you are entering a currency exchange rate.

6. In the **Rate** column, enter the currency exchange rate for the fiscal year and period defined. You can enter rates with up to four places to the right of the decimal. Only one rate is allowed per period. For assistance calculating and entering the rate, click the calculator.

7. When you are finished entering exchange rates, click **Save and Close** to save the exchange rate record and return to the Currency Exchange Rates page. After you add the required exchange rates, you can import subsidiary activity information and use the exchange rates to translate activity that is in a different currency.

**Importing Subsidiary Information**

The process of importing subsidiary information is integral to generating consolidated data. It allows you to move account activity from your subsidiary databases to your consolidated database. When you import information into your consolidation database, you are importing account activity files previously created in your subsidiary databases.
Before importing subsidiary information, make sure you have configured your consolidation database, created and imported account structure files, created consolidation maps using the structure files, defined currency exchange rates (if needed), and created account activity export files in your subsidiary database. If you have completed these tasks, you are ready to import the subsidiary activity into your consolidation database.

- **Importing subsidiary account activity files**

![Consolidation page](image)

**Note:** If you have previously imported subsidiary information and saved the import record, it is displayed on the Import Subsidiary Information page.

2. Click *Import subsidiary information*. The Import Subsidiary Information page appears, displaying any previously saved import records.

4. In the **Import name** field, enter a descriptive name for this consolidation import. You can also enter a description of the subsidiary import file in the **Description** field provided.

5. In the grid, click in the **File Name** column and enter the name of the file to import, as well as the path. To search for the file, click the binoculars. After you enter a file name and path, the **Modified** column displays the date the file was last modified. To enter additional files for importing, place your cursor in the **File Name** column and click **ENTER**.

6. Once you enter a file name and path in the grid, mark the coordinating checkbox located at the beginning of each row. Only files designated with a check mark will be imported. You can exclude a file by clearing the corresponding checkbox.

**Note:** The Subsidiary Import File Report includes detailed information about the account activity import process, including a summary of successfully imported transactions organized by subsidiary, as well as any exceptions that need to be addressed.
7. To automatically print a control report, mark **Print a control report on** and select a default printer. If you would rather preview the control report before printing, do not mark this checkbox.

8. When you are ready to import the export file, click **Import Now**. Once the import is complete, a confirmation screen appears notifying you of success. If you have no exceptions, the import will succeed. However, if exceptions exist, you will need to address the exceptions and attempt the import again.

**Tip:** After you have added and saved a subsidiary import file record, you can reuse it at a later date. This saves you from having to create a new import record each time you import updated subsidiary account activity export files.

9. Click **OK**. Your subsidiary information import is complete. If you marked **Print a control report on**, a Subsidiary Import File Report is automatically sent to the default printer. If you did not mark **Print a control report on**, a preview of the Subsidiary Import File Report appears.

### Retranslating General Ledger Transactions

**Consolidation Management** is designed to help organizations composed of multiple individual corporations generate consolidated financial reports, regardless of currency type. In order to accomplish this, we provide the ability to retranslate general ledger transactions using various currency exchange rates. Once transactions have been imported and translated from one currency to another, you may need to retranslate the transactions with updated exchange rates.

In your consolidation database, you add and maintain the currency exchange rates that are used to retranslate subsidiary activity in foreign currencies to the default currency. This section provides information and procedures for retranslating subsidiary activity that has already been imported into the consolidation database.

- **Retranslating General Ledger Transactions**

  1. Access **General Ledger** from your consolidation database. On the navigation bar, click **Consolidation**. The Consolidation page appears.
2. Click **Retranslate General Ledger Transactions**. The Retranslate General Ledger Transactions screen appears.

3. On the General tab, access the **Currency** field and select the currency type you want to retranslate.

4. In the **Date** field, select an option for defining the period containing the transaction you want to retranslate. Depending on your selection, additional fields may appear to help you define the period. Enter any additional date information.

5. To automatically print a control report, mark **Print a control report on** and select a default printer. If you would rather preview the control report before printing, do not mark this checkbox.

6. Select the Filters tab to designate the transaction you want to retranslate. You can filter transaction by subsidiary, batch, and batch creator. You can choose all or selected transactions based on filters.

7. Once you finish specifying the period and transactions to include, you can click **Preview** to preview the retranslation settings.

8. If the preview looks good, click **Retranslate Now** to begin the process.

9. Once the retranslation is complete, a confirmation screen appears notifying you of success. If you have no exceptions, the retranslation will succeed. However, if exceptions exist, you will need to address the exceptions and attempt the retranslation again.
10. Click **OK**. The retranslation of the designated transactions is complete. If you marked **Print a control report on**, a report is automatically sent to the default printer.

**Revaluing Balances and Activity**

To produce accurate data, we provide the ability to revalue the foreign currency component of balances and year-to-date activity. The revaluing process creates journal entries for unrealized gains and losses due to currency rate differences. This is a necessary process if you need to revalue accounts using current or historic exchange rates.

- **Revaluing balances and activity**
  1. Access **General Ledger** from your consolidation database. On the navigation bar, click **Consolidation**. The Consolidation page appears.

2. Click **Revalue Balances and Year To Date Activity**. The Revalue Balances and Year To Date page appears.
3. Click **New**. The New Retranslation Set screen appears. As part of the revaluing process, you create revaluation sets that you can save and reuse.

4. In the **Set name** field, enter a name for this revaluation set. You can also enter a description in the corresponding field to help identify this set.

5. In the **Revalue** field, select Ending balance and activity or Beginning balance. Additional fields are displayed if you select Ending balance and activity. For this procedure, we selected Ending balance and activity.

6. In the **Revalue for** field, select Today, Specific date, or Specific fiscal period. If you select Specific date or Specific fiscal period, enter the specific date and/or period information.

7. In the **Post Options** frame, access the **Journal** field and select the journal to which you want to post the revalued transactions.

8. In the **Reference** grid, you can customize journal references or leave the defaults. If you make changes and want to restore the defaults, click **Restore Defaults**.

9. To automatically print a control report, mark **Print a control report on** and select a default printer. If you would rather preview the control report before printing, do not mark this checkbox.

10. Select the Filters tab to designate the currency components you want to revalue. You can filter by currency types, subsidiaries, accounts, categories, funds, account codes, account attributes, and other user-define segments. You can choose all or select specific filters.

11. Once you finish specifying the revaluing information, you can click **Preview** to preview the revaluation settings.

12. If the preview looks good, click **Revalue Now** to begin the process.

13. Once the revaluation is complete, a confirmation screen appears notifying you of success. If you have no exceptions, the revaluation will succeed. However, if exceptions exist, you will need to address the exceptions and attempt the revaluation again.

14. Click **OK**. The revaluation of the foreign currency components is complete. If you marked **Print a control report on**, a report is automatically sent to the default printer.
Deleting Subsidiary Batches

By deleting subsidiary batches in Consolidation Management, you can remove subsidiary general journal entry batches from specific periods in your consolidation database.

- **Deleting subsidiary batches**
  
  1. **Access General Ledger** from your consolidation database. On the navigation bar, click **Consolidation**. The Consolidation page appears.

  [Image of Consolidation page]

  2. **Click Delete Subsidiary Batches**. The Delete Subsidiary Batches screen appears.

  [Image of Delete Subsidiary Batches screen]

  3. In the **Creation date** field, select the option to use for defining the creation date of the subsidiary batches to delete. Additional date parameter fields appear depending on your selection. Enter the required date information.

  4. To automatically print a control report, mark **Print a control report on** and select a default printer. If you would rather preview the control report before printing, do not mark this checkbox.
5. Select the Filters tab to designate the filters to use in determining the batches to delete. You can filter by subsidiary, batch, and batch creator. You can choose all or selected filters.

6. Once you finish specifying the batches to delete, you can click **Preview** to preview the batches to be deleted.

7. If the preview looks good, click **Delete Now** to begin the process.

8. Once the batches are deleted, a confirmation screen appears notifying you of success. If you have no exceptions, the batches are deleted. However, if exceptions exist, you will need to address the exceptions and attempt the delete process again.

9. Click **OK**. The specified batches are deleted. If you marked **Print a control report on**, a report is automatically sent to the default printer.

### Consolidation Reports

The basic purpose of *Consolidation Management* is to provide an efficient way for a multi-company organization to generate consolidated financial reports that communicate accurate information about all corporate entities. This reports section provides information about the reports and exclusive functionality available in *General Ledger* when *Consolidation Management* is installed.

All current *General Ledger* reports are available from the consolidation database, some with additional characteristics to provide consolidated information. The following table displays reports that have added characteristics and lists each.

<table>
<thead>
<tr>
<th>Report Category</th>
<th>Report Name</th>
<th>Consolidation Management Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Reports</td>
<td>General Ledger Report</td>
<td>Subsidiary filter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sort and break report by subsidiary</td>
</tr>
<tr>
<td></td>
<td>Trial Balance</td>
<td>Subsidiary filter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sort report by subsidiary</td>
</tr>
</tbody>
</table>
For more detailed information about running these and all General Ledger reports, see the Reports Guide for General Ledger.

### Consolidation Dashboard Panels

*Dashboard* organizes information in your database into a “snapshot” you can easily view with the click of a mouse. Quickly and effortlessly, *Dashboard* summarizes your organization’s most valuable information.

**Glossary:** A panel is a block of information on a dashboard that contains summary, list, and graph information you select. A dashboard contains innumerable panels based on selections you make on the Customize Dashboard screen.

A dashboard contains panels of summaries, lists, and graphs that efficiently compare and analyze information. You can create a variety of panels on the Dashboard page. From most panels, you can open a record in *The Financial Edge* and view or edit information in the actual record.
By using *Dashboard* with *Consolidation Management*, you have increased functionality that enhances various dashboard panels with the option to designate subsidiary-specific information. You can choose to include activity for panels designated by subsidiary and various characteristics, including fund, class, project, and transaction code.

For the following panels, you can choose to include specific consolidation information.

- Accounts over budget
- Balance sheet
- Income statement
- Percentage of expenses
- Percentage of revenues
- Statement of cash flows

Another benefit of *Consolidation Management* is the addition of consolidation-related fields available on various dashboard panels in *General Ledger*.

For more detailed information about *Dashboard*, including step-by-step procedures, see the *Dashboard Guide*. 
# Index

## A
- account activity
  - export files 9
- account structure
  - export files 8
- activity, revaluing 24

## B
- balance, revaluing 24

## C
- configuring
  - *Consolidation Management* 2
  - default consolidation currency 3
- consolidation dashboard panels 28
- *Consolidation Management*
  - configuring 2
  - defaults accounts 4
  - process summary 2
  - security 7
  - subsidiary export files 7
- consolidation map
  - adding 13
  - creating 12
  - tools and options 12
- consolidation report 27
- currency
  - configuring defaults 3
  - exchange rates 18
  - translation rounding 5
  - unrealized gain 4
  - unrealized loss 5

## D
- dashboard panel, consolidation 28
- default account
  - consolidation account 4
  - defining for unrealized currency gain 6
- default consolidation currency, configuring 3
- deleting subsidiary batches 26

## E
- exchange rates for currency 18
- exporting
  - account activity from subsidiary databases 9
  - account structure 8
  - subsidiary export files 7

## G
- gain, unrealized currency 4
- *General Ledger* transactions, retranslating 22

## I
- importing, *The Financial Edge*
  - subsidiary information 19

## L
- loss, unrealized currency 5

## M
- mapping consolidations 12

## R
- report, consolidation 27
- retranslating *General Ledger* transactions 22
- revaluing balances and activity 24

## S
- security, consolidation management 7
- subsidiary
  - deleting batches 26
  - importing information 19

## T
- translation rounding, currency 5
U

unrealized currency gain  
  defining default account 6
  overview 4
unrealized currency loss 5